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The Centers 
WebExTM Recorder and Player User's Guide  
 
 
In partnership with WebExTM Communications, Inc. we provide Meeting Visuals, 
TrainingCenter, SalesCenter and EventCenterTM web conferencing services. Because the 
Centers are powered by WebEx, this guide makes several references to the company 
name, platform and features. 
 
This guide assumes that you have a user account for the Centers and are set up to host 
meetings. 
 

Introducing the WebEx Recorder and Player 
 
Use the WebEx Recorder to create a video recording of all screen activity on your 
computer including mouse movements and annotations.  You can also capture audio in a 
recorded meeting such as the audio from an audio conference.   
 
The WebEx Recorder is available in these versions: 
 
Integrated meeting recorder (also known as Network Based Recording- NBR): The 
integrated recorder lets you create a video of all on-screen activity- including mouse 
movements and annotations – that occurs during an online support session. You can also 
capture audio in a recorded session, such as audio in an audio conference. 

 
Standalone recorder: Available offline, the Standalone Recorder allows you to 
record all activity in an application. You can also capture audio, such as your 
narration or sounds that play in a file. This standalone recorder is useful for 
creating software demonstrations, tutorials, sales presentations, and so on. You 
can download the standalone recorder at www.meetingconnect.net. 
 

Discover the fast, easy way to record, distribute, and 
archive recordings of your WebEx meetings: Our WebEx 
Network-Based Recording (NBR). 
 
Record your meetings as they happen — and play them back as you need. Use WebEx 
Network-Based Recording (NBR) to share information with a wider audience, update 
team members who aren’t able to attend live meetings, and comply with regulations 
requiring documentation of corporate communications.  Available by special order to 
complement your WebEx service, NBR will capture all your session content, including 
WebEx or third party audio, for later playback. You’ll be able to increase the ROI of your 
live sessions and improve the productivity of your teams, as you make recorded WebEx 
sessions readily available to wider audiences. It’s a great way to extend the reach of your 
training program, web seminar marketing program, sales programs, and other initiatives. 
 



  

 
 
 
 
 
 
 
 
It’s easy to use NBR to record all meeting content as it 
happens. No separate hardware is required. Just follow 
simple menus to initiate recording from within your 
session. It takes just seconds. 
 
 

Key Benefits 

HIGH-QUALITY MEETING DOCUMENTATION 

Have a clear, accurate record of any meeting to archive or share for any purpose: 
Reach more people faster with important information. 
Bring team members who miss a live meeting up to date quickly. 
Keep a complete record of important interactions. 

EASY TO USE 

Start recording directly from your WebEx meeting interface, following just a few simple 
steps. 

HIGH-QUALITY RECORDING FORMAT 

Get high-quality recordings stored in the proprietary .arf player. 
Recordings are viewable with the network recording viewer, which users can download at 
no charge. 

EASILY ACCESSIBLE 

Find all your recordings in the “My Files” directory in your “My WebEx” tab. 

 



  

HIGH AVAILABILITY 

Viewers don’t need to download a recorder. When you stream the recording they simply 
click on the link you send them for instant viewing. 
 

WebEx Network-Based Recording FAQs 
 
Q: Which centers can use Network Based Recording? 
A: Meeting Center, Training Center, Sales Center and Event Center 
 
Q: Which operating systems are supported for the host using 
Network Based Recording? 
A: Windows, Mac, and Linux operating systems can all be used by the Host. 
 
Q: Do I need any additional hardware to use Network Based 
Recording for my meetings? 
A: No, you can simply get it enabled on your site. By using the meeting client you use to 
join the meeting you can record all your meeting actions, including the teleconference. 
 
Q: What is the typical size of an hour recording? 
A: The size will vary depending on the action during the meeting. 
Typically, a meeting that does not contain Video usage ranges from 15 to 40 MB. A 
meeting with Video usage can range in the 250MB size. 
 
Q: How long until my recordings are available for viewing or distribution? 
A: Within 30 minutes from the end of your meeting. 
 
Q: Where can I find my recordings? How do I get the WebEx 
Recording Player? 
A: Your recordings are posted to the “My Files” directory under “My Recordings” in My 
WebEx. The Player can be downloaded from the “Support” Page on your WebEx site. 
 
Q: How do I publish my recording to my attendees? 
A: Once your recordings are posted to the “My Files” directory in My WebEx, a streaming 
URL is generated and can be sent via email, posted to your WebEx Site, or any other 
website. 
 
Q: Does Network Based Recording capture all the content of the meeting? 
A: It records the full attendee-view of the meeting, so it captures: 
 

 All public chat. 
 All data including annotations, polls results that are shared, notes (requires 
publishing). 
 Presenter video (requires at least one attendee present in the meeting) and audio. 

 
It does not capture: 
 

 All private chat to the host. 
 Poll results not shared by the host. 
 Breakout sessions (TC), Media Viewer (EC), Closed Captioning (MC), and Practice 
Rooms (EC) Panels are not recorded or playback 
 When recording MPV, only the Presenter’s Video is recorded and play backed 

 



  

Q: Does Network Based Recording capture third party audio? 
A: Yes. By entering your third party conference number in the start recording process, 
third party audio will be captured. 
 
Q: Does NBR support Auto Recording? 
A: No. It is planned for a later release 
 
Q: Why do you have to specify what type of recording in the wizard when you have 
already done it in Settings? 
A: The wizard is there so that users are aware of the two options. 
Users can choose to skip this part in the future. 
 

Specifications 
 
Supported Services All centers except support 
Supported Platforms Windows, Mac and Linux 
WebEx Platform Requirements WBS25+ 
NBR Hardware Needed None 
File Formats Advanced Recording Format.arf 
Recording Conversion Webex .arf to Windows Media .wmv and 

Flash .swf 
Recording Resolution 1024x768 
Audio Recording WebEx or Other Teleconferencing Service 
Recording Player: WebEx Network Recording Player 
File Size Typically 15MB to 40MB per Hour of 

Meeting 
Time; Results Vary by Meeting Content 

Max Recording Length 12 hours 
Storage/Distribution Saves to WebEx “My Files,” able to stream, 

download, and/or publish the recording 
URL 

My Files Storage 1 GB free per Site, additional storage 
available 

  
 

ABOUT THE STANDALONE RECORDER 

 
The integrated meeting recorder is available during any of the meetings.  This recorder 
captures screen activity and audio in a meeting and then saves the recorded data in a 
recording file on your computer. 
 
Use the integrated recorder to capture all audio that plays through your computer. You 
can also capture audio from an audio conference using a phone recording adapter, which 
connects your phone to your computer. 

 

 



  

ABOUT THE WEBEX PLAYER 

 
The standalone recorder is only available offline - that is, outside of a web conference.  
This recorder lets you record all screen activity in any application on your computer and 
then saves it in a recording file on your computer. 
 
Use the standalone recorder to create software demonstrations, tutorials, sales 
presentations, etc.  To capture audio in a recording, simply connect a microphone to your 
computer.   
 
You can download the standalone recorder from www.meetingconnect.net: 

 
For per minute users or from your branded website by entering: 
<http://companyname.webex.com/companyname/tool/record/record_play.php>.  If you do 
not know your branded site URL please contact your site administrator or your sales 
representative. 
 
To start recording an online meeting: 
 
To play any recording in the WebEx Recording Format (.wrf) you must use the WebEx 
Player.  Using WebEx Player, you can play a recording that resides on your computer, a 
server on your local network or a website on the Internet.   
 
You can download WebEx Player from the Centers’ websites for per minute users or on 
your branded website by entering: 
<http://companyname.webex.com/companyname/tool/record/record_play.php>.  If you do 
not know your branded site URL please contact your site administrator or your sales 
representative. 
 

System Requirements for Recorder and Player 
 
The following are the minimum system requirements for WebEx Recorder and Player: 
 

 Microsoft Windows 95, 98, Me (Millennium Edition), XP, 2000, or NT 
 Microsoft Internet Explorer 4.x or a later version, or Netscape 4.x or a later version 

 
 
Note: By default, only the host and the presenter can record an online meeting. Attendees can record an online 
meeting only if a presenter grants recording privileges to them. 
To record audio, ensure that your computer meets the system requirements and you set up the appropriate audio 
input device. For details, see the “Recording Audio” section. 

Using the Integrated Recorder 
 
When you record an online session for the first time, the Manager downloads and installs 
the WebEx Player on your computer.  
 
Each Manager is referenced according to its respective product name (MeetingCenter 
uses Meeting Manager, TrainingCenter uses Training Manager, SalesCenter uses Sales 
Manager and EventCenter uses Event Manager.) 
Once you start recording an online meeting, the integrated Recorder begins saving the 
recording to a file on your computer. Ensure that you have enough space on your hard 



  

disk for a recording. For information about file size estimates for recordings, see the “File 
Size Estimates for Recordings” section. 
 
To capture audio in a recorded meeting, you must set up your computer’s sound card and 
attach the appropriate audio input device. For more information, see the “Recording 
Audio” section. 
 
To start recording an online meeting: 
 

1 For MeetingCenter and SalesCenter: On the Meeting menu, choose Start 
Recording.  
 

  
 
For TrainingCenter: On the Session menu, choose Start Recording 
.  

 
 

For SupportCenter: On the CSR Dashboard, click the Session tab, and then click          
Record Session 

 

  
 

2 Choose a location at which to save the recording. 
 



  

        
 

3 In the File Name box, type a name for the file and then click Save. 
The Recorder Panel appears. 

 
4 On the Recorder Panel, click the Record button. 

 

       
 
The Progress and file size indicator on the Recorder Panel indicates the current duration 
of the recording, in hours, minutes and seconds; and the current file size of the recording 
file, in kilobytes. 
 
To pause and then resume recording: 
 

1 On the Recorder Panel, click the Pause button. 
 

 
2 Then, to resume recording, click the Resume button. 
 

 
To stop recording: 
 
On the Recorder Panel, click the Stop button. 
 

 
 
Or, alternatively, use the Tools drop down menu to stop the recording. (For 
MeetingCenter,and TrainingCenter only) 



  

 
WebEx Recorder saves your recording to a file in the WebEx Recording Format, which 
has a .wrf extension. 
 

   
 

Using the Standalone Recorder 
 
To record an application on your desktop offline – that is, outside of an online meeting – 
you must use the standalone version of the WebEx Recorder. 

RECORDING AN APPLICATION ON YOUR DESKTOP 

 
Once you start recording an application on your desktop, the standalone recorder begins 
saving the recording to a file on your computer.  Ensure that you have enough space on 
your hard disk for a recording. 
 
To capture audio in a recording, you must set up your computer’s sound card and attach 
the appropriate audio input device.   
 
To start WebEx Recorder: 
 
Do either of the following: 
 

 Click Start, point to Programs, point to WebEx Recorder & Player then click WebEx 
Recorder. 
 Double-click the WebEx Recorder shortcut on your computer’s desktop. 

 

 
 
The WebEx Recorder console appears. 
 

 
 
To start recording: 
 

1 On the WebEx recorder console, click the Open Application button. 
2 In the WebEx recorder - Open Application dialog box, select an application on 

your desktop. 
 



  

 
 

3 Click Select. 
4 Choose a location at which to save the recording. 
5 In the File Name box, type a name for the file then click Save.  The Recorder 

Panel appears. 
6 On the Recorder Panel, click the Record button. 

 

 
 
The Progress and File Size indicator on the Recorder Panel indicates the current duration 
of the recording in hours, minutes and seconds and the current size of the recording file in 
kilobytes. 
 

 
 
To pause and then resume recording: 
 
On the Recorder Panel, click the Pause button.   

 
 
To resume recording, click the Pause button again. 
 
To stop recording: 
 
On the Recorder Panel, click the Stop button. 
 



  

WebEx Recorder saves your recording to a file in the WebEx Recording Format which 
has a .wrf extension. 
 
To quit WebEx Recorder: 
 
On the File menu, choose Exit. 

SWITCHING TO ANOTHER APPLICATION DURING RECORDING 

 
Once you start recording an application using the standalone recorder you can switch to 
recording another application without stopping WebEx Recorder.  Thus, you can create a 
single recording that captures your actions with two or more applications in a sequence. 
 
To switch to another application during recording: 
 

1 Pause recording.  The WebEx Recorder button appears on your computer’s 
taskbar. 

 

 
 
2 Click the WebEx Recorder button to display the WebEx Recorder – Open 

Application dialog box. 
3 In the list, highlight the application that you are currently recording. 
4 Click Unselect. 
5 In the list, select another application to record. 
6 Click Select. 
7 Resume recording. 

 
 
RECORDING MULTIPLE APPLICATIONS SIMUTANEOUSLY  
(SupportCenter Only) 
 
Once you start recording a single application, you can start recording another application 
simultaneously, without stopping WebEx Recorder. 
 
To record multiple applications simultaneously: 
 

1 Pause recording. The WebEx Recorder button appears on your computer’s 
taskbar. 

2 Click the WebEx Recorder button to display the WebEx Recorder – Open 
Application dialog box. 

3 In the list, select another application that you wan to record. 
4 Click Select. 
5 Resume recording 

Granting Recording Privileges to Attendees (For 
MeetingCenter and TrainingCenter Only)  
 
By default, only the meeting host and the presenter can record a meeting. However, you 
can allow an attendee or all attendees to record a meeting. You can also remove 
recording privileges from attendees at any time. 
 



  

 
To grant or remove recording privileges: 
 

1 In the Meeting Window, on the Participant menu choose Assign Privileges.  The 
Participant Privileges box appears. 

2 On the Participant Privileges dialog box, click on the Participants tab. 
3 To give an attendee recording capabilities, select attendees name and then the 

Record a meeting check box. 
 

          
 
 

4 Click Assign. The Attendee will now have the Meeting Recorder option available 
under their Tools drop down menu. 

5 To prevent attendees from recording a meeting, clear the Record a meeting 
check box and click Assign. 

 

Hiding the Recorder Panel During Recording  
 
Normally, the Recorder Panel appears on your screen during recording. However, before 
you begin recording, you can hide the Recorder Panel. If the Recorder Panel is hidden, 
you can pause or stop recording by pressing a hot key—that is, a key or combination of 
keys on your computer’s keyboard. 
 
To hide the Recorder Panel: 
 

1 Do one of the following: 
- If you are using the integrated Recorder, on the Tools menu in the Meeting 

window, point to Recorder Privileges and then choose Recorder Settings. 
Choose the Recorder Panel tab. 

- If you are using the standalone Recorder, on the Recorder console, on the 
Settings menu,  choose Recorder Panel. 

- For SupportCenter: On the Recorder console for the standalone recorder, on the 
Settings menu, choose WebEx Recorder Settings.  

 
 
 
 



  

 
 
The WebEx Recorder Settings dialog box appears. 
 

        
 

2 Under Recorder Panel select the Hide the Recorder panel during recording check 
box. Default hot keys appear in the Pause/Resume and Stop boxes. While 
recording, you can press the appropriate hot key to stop or pause recording. 

3 Optional: To specify your own hot keys, click in the Pause/Resume or Stop boxes 
and then do one of the following: 
a. Hold down the Control or Shift key and then press another key. 
b. Hold down both the Control and Shift keys and then press another key. 

4 Click OK. 
 
To show the Recorder Panel after it is hidden: 
 
During recording, press the hot keys that you specified to either pause or stop recording. 
The default hot keys are the following: 
 

 Pause recording— Ctrl+Alt+P key combination 
 Stop recording— Ctrl+Alt+S key combination. 

 

Recording Annotations 
 
While recording, you can use the highlighter tool to make annotations.  Your annotations 
appear in the recording during playback. 
 

MAKING ANNOTATIONS WHILE RECORDING A MEETING 

 
When using the integrated recorder to record a MeetingCenter meeting, you can use the 
annotation tools available in the meeting.  For example, if you are sharing an application, 



  

any annotations you or other participants make using the annotation tool on the Tools 
panel will appear in your recoding.   
         

MAKING ANNOTATIONS USING THE STANDALONE RECORDER 

 
To make annotations using the standalone recorder: 
 
Do any one of the following: 
 

 On the Recorder panel, click the Annotate button. 
 

  
 

 In the lower-right corner of your computer’s task bar, click the Recording button.  

 Then, on the menu that appears, choose Annotate. 
 
 In the title bar of the application you are recording, click Recording.   

Then, on the menu that appears, choose Annotate. 
 
 An annotation drop down menu button appears on your screen and your mouse 
pointer changes to a highlighter.   

   
 
To change your annotation color: 
 

1 Click the Annotation drop-down menu. 
2 On the color palette that appears, choose Annotation Colors. 
3 Select a different color. 

 
To exit annotation mode: 
 

1 Click the Annotation drop-down menu.  
2 On the menu that appears, choose Stop Annotating. 

 

Inserting Markers into a Recording 
 
During recording, you can insert one or more markers into a recording.  A marker is a 
placeholder that lets you quickly located a position in a recording file when editing it using 
WebEx Recording Editor. 
 



  

For example, if you are recording a MeetingCenter meeting and someone makes an 
important comment, you can quickly insert a marker into the recording at that time.  Then, 
when editing the recording, you can quickly locate the point in the recording at which the 
comment was made. 
 
You can insert a marker using either the Recorder Panel or a hot key – that is, a key or 
combination of keys on your computer’s keyboard.  A hot key is useful if you set up the 
Recorder Panel to be hidden during recording.   
 
To insert a marker into a recording using the Recording Panel: 
 
On the Recorder Panel, click the Insert Marker button. 

 
 
 
To insert a marker into a recording using hot key: 
 

1 Do either of the following: 
 

 If you are using the integrated recorder, on the Meeting menu in the Meeting 
window, choose Recorder Settings > Recorder Panel. 

 
The WebEx Recorder Settings dialog box appears.  On the Recorder Markers tab, a 
hotkey appears in the box.  While recording, you can press this hot key to insert a marker. 
 

 
 
 

 If you are using the standalone recorder, on the Recorder console, on the Settings 
menu, choose WebEx Recorder Settings. 

 
 



  

The WebEx Recorder Settings dialog box appears.  On the Recorder Markers Settings, a 
default hot key appears in the box.  While recording, you can press this hot key to insert a 
marker. 
 
 

 
 

2 Optional – To specify your own hot key, click in the box then do one of the 
following: 
a. Hold down the Control or Shift key then press another key 
b. Hold down both the Control and Shift keys then press another key. 

3 Click OK. 
 

Recording Audio 
 
WebEx Recorder automatically synchronizes audio with your sequence of actions in an 
application or meeting. In order to capture audio, you will need a phone line. This can be 
a direct phone line or an audio conference line. 
 

SYSTEM REQUIREMENTS FOR RECORDING AUDIO 

 
To record audio, ensure that your computer meets the following system requirements: 

 Intel Pentium III 667 MHz or faster 
 128 MB RAM or more 
 Creative Labs Sound Blaster or equivalent sound card 
 Input device for capturing audio 

 
NOTE: Use an input device that is appropriate for the type of audio that you want to capture. 

 

 

 



  

INPUT DEVICES FOR RECORDING AN AUDIO CONFERENCE 

 
To record an audio conference for an online meeting, you must connect the recording 
computer to a telephone using one of the following: 
 

 Phone recording adapter—Connects your phone to your computer’s sound card. A 
phone recording adapter captures all audio in a teleconference. The following two 
phone recording adapters from DynaMetric, Inc. are  compatible with WebEx 
Recorder: TLP-102 Telephone Logger Patch and TMP-636 Transmit and Receive 
Patch.  To connect a phone recording adapter to your computer’s sound card, 
follow the instructions that DynaMetric provides. 

 

        
 
To record audio in rich media files, such as audio and video files, you must use a phone 
recording adapter that supports bi-directional audio between your phone and computer—
that is, connects to both the input and output jacks for your computer’s sound card. The 
DynaMetric TMP-636 adapter supports bi-directional audio. 
 
To purchase a DynaMetric phone recording adapter, please visit the following web 
address: www.dynametric.com/webex_purchasing.html or contact your sales 
representative. 
 

 Universal multimedia amplifier —Connects your telephone to a headset and your 
computer’s sound card. You can use a universal multimedia amplifier as a phone 
recording adapter to capture all audio in an audio conference. Using a universal 
multimedia amplifier is ideal if you often speak an audio conference, Internet phone 
conferences and standalone recording sessions, because it allows you to switch 
between a phone headset and a computer headset.  

 
The following universal amplifier is known to be compatible with WebEx Recorder: 
Plantronics MX10 Universal Amplifier. 
 
To record audio in shared files, such as UCF rich media files, you must use a universal 
multimedia amplifier that supports bi-directional audio between your phone and 
computer—that is, connects to both the input and output jacks for your computer’s sound 
card. The Plantronics MX10 Universal Amplifier supports bi-directional audio. 
 
To purchase a Plantronics universal multimedia amplifier, please visit the following web 
address: www.plantronics.com 

http://www.dynametric.com/webex_purchasing.html
http://www.plantronics.com/


  

 
 Conference phone with RCA output jack   
 To capture audio using a conference phone or speakerphone, connect the phone’s 
RCA audio output jack to the microphone input jack on your computer’s sound 
card. 

 
NOTE: For better audio quality and convenience, use a phone headset when recording an audio conference. 
      

SETTING UP YOUR SOUNDCARD FOR RECORDING AUDIO 

 
Before you start recording audio, do the following to set up your computer’s sound card: 
 

1 Select sound card —Select the sound card that you want to use for recording 
and playing sound, if your computer has multiple sound cards. 

2 Adjust audio volume  
a. Adjust the audio input volume for your microphone or phone, which 

determines the sensitivity of WebEx Recorder when capturing audio. 
b. Adjust the audio output volume for your speakers or earphones. 

3 Specify microphone settings  
a. For recording, ensure that the microphone input setting is either selected or 

not muted, depending on your sound card, and that all other input controls 
are either muted or not selected. 

b. For playback, ensure that the microphone input setting is either not selected 
or muted, depending on your sound card. 

 
You can set up your computer’s sound card in either of two ways: 
 

 Use the Audio Setup Wizard, which is available in the standalone WebEx Recorder 
only. The wizard automatically specifies the correct recording and playback settings 
for your microphone. 
 Use your sound card’s volume controls and Windows Sound Recorder to manually 
set up your sound card. 

 
To use the Audio Setup Wizard to set up your sound card: 
 

1 On the WebEx Recorder console, on the Settings menu, choose Audio Setup 
Wizard. 

2 Follow the instructions in the wizard. 



  

t up your sound card manually: 

1 Open your sound card’s volume controls as follows: 

nd then point to Entertainment. 

ne sound card, in the Mixer device 

nsure that the Microphone setting is either 

nsure that the Microphone setting is either 

s: 

nd then point to Entertainment. 

your voice as you speak into the audio input 

     

        
To se
 

a. On your computer’s desktop, click Start 
b. Point to Programs point to Accessories, a
c. Choose Volume Control.  The Volume Control dialog box appears. 

2 On the Options menu, choose Properties. 
3 Optional. If your computer has more than o

drop-down list, select the sound card that you want to use for recording. 
4 Select Playback and then click OK. 
5 In the Volume Controls dialog box, e

muted or not selected, depending on your sound card. 
6 On the Options menu, choose Properties again. 
7 Select Recording and then click OK. 
8 In the Recording Control dialog box, e

selected or not muted, depending on your sound card. Leave the Recording 
Control dialog box open on your screen. 

9 Start Windows Sound Recorder, as follow
a. On your computer’s desktop, click Start. 
b. Point to Programs, point to Accessories a
c. Choose Sound Recorder. 

10 Use Sound Recorder to record 
device that you want to use when making the actual recording. 

 

 
 

11 While speaking, adjust the Microphone volume as necessary using the Volume 

se the Microphone volume. If the audio is distorted, 

ur voice and adjusting the Microphone 

File Size Estimates for Recordings 

slider in the Recording Control dialog box. 
12 Play back your recording. 
13 If the audio is too low, increa

decrease the Microphone volume. 
14 If necessary, continue recording yo

volume. 

 
Without audio, WebEx Recorder captures approximately 10 MB of video data per hour of 

 

hen recording audio, the rate at which WebEx Recorder captures data depends on the 

recording. However, when recording frequent actions in an application or meeting, WebEx
Recorder may capture significantly more data. 
 
W
audio sampling rate that you select. The following are estimates of the data that WebEx 
Recorder captures for the available audio sampling rates. 
 
 
 
 



  

 YOU SET WEBEX RECORDER TO IT CAPTURES APPROXIMATELY THIS 
 
IF
THIS AUDIO SAMPLING RATE: AMOUNT OF AUDIO AND VIDEO DATA 

PER HOUR: 
G.723 at 8 KHz 15 MB 

PCM at 8 KHz 70 MB 

PCM at 22 KHz 170 MB 

PCM at 44 KHz 325 MB 

 
  Distributing Your Recordings 

nce you complete a recording, you can distribute it in the following ways: 
 
O
 

 Ask your company’s Webmaster to publish your recording on your organization’s 

e 

website.  Once a visitor to your site clicks a link for a recording, a playback server 
automatically downloads the WebEx Player software to the visitor’s computer, if 
necessary, then streams the recording to the visitor’s computer.  By streaming 
recordings, you allow visitors to play recordings without the need to download th
recordings onto their computers.  For more information about streaming a 
recording, please go to www.meetingcenter.net/record_play.htm . 

 
 Provide your recording file directly to the people whom you want to view it.  If they 

Using WebEx Player 

do not have the WebEx Player, they can download the WebEx Player installation 
program from the Recording and Playback page on 
www.meetingcenter.net/record_play.htm.   

 

 
Using WebEx Player, you can play back any recording that was made using WebEx 

INSTALLING WEBEX PLAYER 

 you do not yet have WebEx Player, or want to download the WebEx Player installer for 

SYSTEM REQUIREMENTS FOR LISTENING TO AUDIO IN A 

ou can listen to audio in a WebEx Recording Format (.wrf) file, if your computer has the 

Recorder—that is, a WebEx Recording Format (.wrf) file. 
 

 
If
users to whom you want to provide a recording, you can download it from 
www.meetingcenter.net/record_play.htm. 

RECORDING 

 
Y
following: 
 

 a Creative Labs Sound Blaster or equivalent sound card 
 speakers, or headphone jack and headphones   

      

http://www.meetingcenter.net/record_play.htm


  

 

PLAYING A RECORDING 

 
You can play a recording that resides on your computer or that is published on a Web 
site. 
 
To start a WebEx Player: 
 
Do either of the following on your computer’s desktop: 
 

 Click Start, point to Programs point to WebEx Recorder & Player, and then click 
WebEx Player. 
 Double-click the WebEx Player shortcut on your computer’s desktop.  

 
 
The WebEx Player console appears. 
 

 
 
To play a recording that resides on your computer: 
 
Do either of the following: 
 

 Double-click a WebEx Recording Format (.wrf) file. WebEx Player starts and plays 
the recording automatically. 
 
 On the WebEx Player console, click the Open button, and then select a recording. 
Then, on the WebEx Player console, click the Play button. 

 

  
 
To play a recording that is published on a website: 
Go to the web page on which the recording is published, and then click the link for the 
recording.  WebEx Player plays the recording automatically. 
 



  

To pause and then resume playback: 
To pause playback, on the WebEx Player console, click the Pause button. 
 

 
 
Then, to resume playback, on the WebEx Player console, click the Pause button again. 
 
To automatically repeat (loop) playback: 
On the WebEx Player console, on the Controls menu, choose Loop. 
 
To stop a playback: 
On the WebEx Player console, click the Stop button. 
 

 
 
To quit WebEx: 
On the WebEx Player console, on the File menu, choose Exit. 

NAVIGATING AND RECORDING 

 
When playing a recording, you can fast forward or rewind the recording. If segments were 
defined in the recording, you can navigate to a specific segment. 
 
To fast forward playback: 
 
Do either of the following: 
 

 To browse a recording while fast forwarding it, click the Forward button. Each click 
moves the recording forward incrementally. 

 

 
 
 
 
 
 



  

 To fast forward a recording to a specific location, drag the playback slider to the 
right. 

 

   
 
 
To rewind a recording: 
 
Do either of the following: 
 

 To browse a recording while rewinding it, click the Rewind button. Each click moves 
the recording backward incrementally. 

 

 
 

 To rewind a recording to a specific location, drag the playback slider to the left. 
 

 
 
To navigate to the next or previous segment: 
 
Click the Previous Segment button or Next Segment button, as appropriate. 
 
NOTE: If no segments were defined in the recording, the Previous Segment and Next Segment buttons are 
unavailable. 
 
To navigate to a specific segment: 
 

1 On the Controls menu, point to Segment. 
2 Choose Go to. The Go to Segment dialog box appears. 

 

 
 
If segments were defined in the recording, they appear in the list. 
 

3 In the list, select a segment. 
4 Click OK. 



  

CONTROLLING FULL-SCREEN VIEW OF PLAYBACK 

 
During playback, you can switch your view of a recording between a standard window and 
a full-screen view. A full-screen view of a recording fits your entire screen and does not 
include a title bar or scroll bars. You can also set WebEx Player to display all recordings 
in a full-screen view by default. 
 
To display a recording in full screen view: 
 
Click the Full Screen button. 
 

 
 
To display a recording in a standard window: 
 
Click the Full Screen button again. 
 
To display all recordings in a full-screen view by default: 
 

1 If you have not done so already, open a recording file (.wrf). 
2 On the WebEx Player console, on the Controls menu, choose Settings.  The 

Playback Settings dialog box appears. 
 

 
 

3 Under Full Screen Setting, select the Play back in full screen mode by default 
check box. 

4 Click OK. 
 

ADJUSTING AUDIO DURING PLAYBACK 

 
During playback of a recording, you can increase or decrease the audio volume, or mute 
or unmute audio. 



  

 
To adjust playback volume: 
 
Drag the Volume slider to the right or left to increase or decrease volume, respectively. 
 

      
 
 
To mute audio:  
 
Click the Mute button. 
 

      
 
To unmute audio: 
      
Click the Unmute button. 
 

 

HIDING OR SHOWING THE PLAYER CONSOLE 

 
Normally, the WebEx Player console appears on your screen when you are playing a 
recorded meeting. However, you can hide the WebEx Player console during playback. If 
the WebEx Player console is hidden, you can pause or stop playback by pressing a 
preset hot key—that is, a key on your computer's keyboard. 
       
To hide the Player console during playback: 
 

1 If you have not done so already, open a recording file (.wrf). 
2 On the WebEx Player console, on the Controls menu, choose Settings. The 

Playback Settings dialog box appears. 
 

        



  

 
3 Under Player console settings, select the Hide Player console during playback 

check box. 
4 Click OK. 

 
While the WebEx Player console is hidden, you can: 
 

 pause and resume playback by pressing the Ctrl+Alt+P key combination on your 
keyboard 
 stop playback by pressing the Ctrl+Alt+S key combination on your keyboard 

 
To make the WebEx Player console appear after it is hidden: 
 

1 During playback, pause or stop playback by pressing the Ctrl+Alt+P or Ctrl+Alt+S 
key combination on your keyboard, respectively. 

2 Optional - To keep the WebEx Player console visible, do the following: 
3 On the WebEx Player console, on the Controls menu, choose Settings. 
4 Under Player Console Settings, clear the Hide the Player Console during 

playback check box. 
5 Click OK. 

UNINSTALLING THE WEBEX RECORDER AND PLAYER 

 
You can remove the standalone version of WebEx Recorder and WebEx Player from your 
computer, using your computer’s Add/Remove Programs utility. Uninstalling the software 
does not remove any recordings that reside on your computer. 
 
To uninstall WebEx Recorder and Player: 
 

1 Open the Windows Add/Remove Programs utility on your computer. 
2 In the list of programs, select WebEx. 
3 Click Change/Remove 
4 In the Uninstall WebEx Software dialog box, select Meeting Manager. 
5 Click Uninstall. 

 
 
 


